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Installation

Connect the MCS2 USB to a USB port on your Mac or on a powered USB hub. It is not 
recommended that you connect the MCS2 to a USB port on a USB keyboard or on an 
unpowered hub.

Note: if you have previously installed a version of the MCS2 software earlier than 2.5, 
you must uninstall it before installing this version.

After downloading and double-clicking the Install_MCS2_USB_2.5.dmg file, you should 
see the following window:

Drag the icon labeled MCS2 USB Software over the icon labeled Applications alias 
then release the mouse. This will cause the Finder to copy the MCS2 software to your 
Applications folder.
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Once the copy is complete, open the /Applications/MCS2 USB Software/ folder 
and double-click on the MCS2-USB application.

If this is the first time you are installing this software, or if you are installing a newer 
version, an installation dialog will appear. Click on Continue to finish the installation, or 
Cancel if you want to finish it the next time you run the MCS2-USB application. The 
installation must be completed before the MCS2 software will be fully functional.
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Once all the software components have been installed, click on the Finish button. A 
connection will be established between the MCS2 software and the MCS2 hardware, 
and you can start working with the software.

Uninstalling

To uninstall run the MCS2 Uninstaller located in the /Applications folder. Click on 
the Uninstall button to begin. When the uninstall is finished, click on the Quit button.

If there are multiple user accounts on this Mac, there may be multiple installations of the 
MCS2 software, one for each user. Each user shares the MCS2-USB application and 
the MCS2 uninstaller, but other software components are installed separately for each 
user account. For this reason, the uninstaller does not remove itself or the MCS2 USB 
Software folder. Before deleting either of these, please make sure that the software has 
been uninstalled from all user accounts.

After uninstalling, you may notice that the MCS2 driver still appears in the Audio/MIDI 
Setup ( /Applications/Utilities/ ) MIDI window. This is because the Mac OS X 
tries to remember the state of your MIDI setup, even if there are changes such as 
removing or powering down equipment or removing drivers.
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Although the driver has no effect at this point, you can remove it from Audio/MIDI 
Setup if you wish. To remove the driver, disconnect the MCS from the Mac and wait for 
the driver’s icon in Audio/MIDI Setup to be dimmed as in the graphic below.

Click on the MCS2 USB icon to select it, then hit the DELETE key on the Mac keyboard 
or choose Delete from the Edit menu. Quit Audio/MIDI Setup.

The MCS2 software’s preference file is not removed by the uninstaller. It takes up 
relatively little space and should have no impact on the operation of other software once 
the MCS2 software is uninstalled. If you want to remove it, just delete the file ~/
Library/Preferences/com.jlcooper.MCS2USB.plist.

System Setup

The MCS2 software relies on Apple’s Universal Access to perform mouse emulation. In 
order for the MCS2 software to work correctly, you must open System Preferences and 
go to the Universal Access pane. Make sure “Enable access for assistive devices” 
is checked then quit System Preferences.
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Introduction to the MCS2 USB Software

The MCS2 Software extends the MCS2 hardware’s ability to control various applications 
running on your Macintosh™. It does this by communicating with applications via MIDI, 
USB and other messaging protocols built into the Mac OS. It can also simulate mouse 
clicking and dragging, keystrokes and can even emulate other control surfaces if 
necessary.

Keysets

The MCS2 software uses “keysets” which are sets of various actions that are taken 
when MCS2 controls are pressed or turned. Different keysets can be applied to different 
applications, and the MCS2 will choose the correct keyset for whichever application is in 
the foreground. If no keyset has been created for the current foreground application, the 
MCS2 will use a built in keyset called the “Default” keyset.

To create or edit MCS2 keysets, open the application, “MCS2-USB”. To create a new 
keyset, choose New Keyset in the File menu and navigate to the application that will 
use the new keyset. You can also use Import Keyset from the File Menu to get an 
existing keyset. Keysets that ship with the MCS2 are located at /Applications/MCS2 
Software/keysets/. You only need to use New Keyset or Import Keyset once for a 
given application. After that, keysets are stored with the MCS2 software’s preferences.

You can use Export Keyset from the File Menu to save a copy of a keyset so it can be 
transported to another Mac or archived for safekeeping. You don’t need to use Export in 
your daily use of the MCS2. As previously pointed out, your changes are added to the 
MCS2 software’s preferences file automatically.

There are several sample keysets included in this package, including ones for Final Cut 
Pro™ and Soundtrack Pro™.

Editing Keysets

The application presents a graphical representation of the MCS2 front panel. When you 
click on an on-screen control (or move a control on the MCS2 itself), that control is 
selected and information about it appears in the floating Inspector window.
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You can choose which keyset to edit within the MCS2-USB application using the 
Keysets menu. The menu lists all keysets that you have created or imported. The name 
of the currently selected keyset will be displayed at the bottom of the main window.
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Jog and Shuttle

The wheel on the MCS2 can serve either as a Jog or a Shuttle control. When the JOG 
button is pressed so that the JOG LED is lit, then the wheel behaves as a Jog control. 
When the JOG button is pressed again so that the LED is not lit, then the wheel 
becomes a Shuttle control.

The MCS2 software treats the Jog and Shuttle as two different controls which can be 
programmed independently of each other. While the the wheel is turning in Jog Mode, it 
continuously sends messages that tell how far and in what direction it has moved since 
the previous message.

In Shuttle mode, the wheel has a “dead zone” around the position it is in when Shuttle 
mode is first turned on. Turning it clockwise sends values from 1 to a maximum of +15. 
When turning it counter clockwise the maximum value is -15.

To select the Jog control for editing, either click on the onscreen wheel, click on the 
onscreen JOG button so that the Jog LED is on, or turn the wheel on the MCS2 while 
the JOG LED is lit.

   

To select the Shuttle control, either click on the word SHUTTLE above the onscreen 
wheel, click on the onscreen JOG button so that the Jog LED is off, or turn the wheel on 
the MCS2 while the JOG LED is off.
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Option and Shift Buttons

There are two ways to treat the Option and Shift buttons: As modifier keys, where they 
change the behavior of the other controls on the MCS2, or as programmable buttons. 
You can set this up by Going to MCS2-USB > Preferences.

 
When the Option and Shift buttons are set to act as modifiers, they essentially become 
selectors for four banks of transport controls. They only work while they are held down. 
Releasing the modifiers returns to the first bank.

MCS2 USB Software
9



For a simpler setup, choose Option and Shift Keys are Programable. In this mode, 
there are no additional banks, and the Option and Shift buttons behave just like the 
transport buttons, giving you one bank with seven programmable buttons, a Jog control 
and a Shuttle control.
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The Inspector Window

The Inspector window is where all your work takes place. It displays information about 
the currently selected control and contains the facilities for editing that information.

The Name text box allows you to give a control a more descriptive name that describes 
its precise function. In the example above, the “Play” button has been assigned an 
action that starts playback from the current time indicator, so naming the button “Play 
From Current Time” conveys more information than “Play”.

If the selected control is a button, then immediately below the Name you will see a 
“Latched” checkbox that lets you choose between a momentary (pressing the button 
turns it “on”, releasing it turns it “off”) or latched (pressing and releasing it turns it “on” 
and pressing and releasing it a second time turns it “off”) behavior.
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Next is a description of the action that is to take place when the selected MCS2 control 
is pressed or turned while the target application is active. Below that is the area where 
this action can be edited. There are a series of tabs representing the different kinds of 
actions that can be performed. Clicking on one of these tabs will display controls for 
editing its kind of action. The available actions are Built In, Keystrokes, Mouse, MIDI, 
Special and Emulation.

Any changes made in one of these tabs are immediately applied to the selected control. 
The MCS2 software allows multiple levels of Undo, so you can easily get back to any 
starting point.

Also at the bottom of the Inspector window is the Delete Action button. When pressed 
it will delete the action currently assigned to the selected control. This is also undoable.
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Action Tabs

Keystrokes Tab

The MCS2 controls can be assigned to send a sequence of keystrokes to an application 
just as if they were keys on the Mac keyboard. These assignments are set up in the 
Keystrokes Tab.

Select a control to edit, place the cursor in the Keystroke field and type a key. If you 
hold down any modifier keys (command, shift, option or control) while typing this key, 
the modifier checkboxes will be set up accordingly. You can also manually change the 
modifier checkboxes by clicking on them.
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Some key/modifier combinations may be intercepted by the operating system before 
they reach the Inspector window. If this happens, just type the key without any 
modifiers, then click on the appropriate checkboxes to add the desired modifiers.

To add more keystrokes to the sequence, click on the Next button and repeat the above 
procedure. You can move forwards or backwards in the sequence with the Next and 
Previous buttons. The Delete Keystroke button will remove the currently displayed 
keystroke from the sequence.

If Repeat while pressed is checked, the keystroke (or sequence) will repeat as long as 
the MCS2 control is held down. The speed of the repeat is controlled by the Repeat/
Typing Speed slider. This slider also determines how much time there is between 
keystrokes if the sequence is more than one keystroke.

If the key sequence in the example below was assigned to the STOP button, pressing 
and holding STOP would be the equivalent of repeatedly typing the word “mark” until 
STOP was released.

The Keystrokes tab can vary depending on the type of MCS2 control selected. For the 
Jog Wheel, different key sequences can be assigned to each direction. Click on the 
Counter Clockwise or Clockwise radio button to choose which direction’s sequence to 
edit.
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In the example below, a counter clockwise turn would send a “-” and a clockwise turn 
would send a “+”.
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The Shuttle Control can have a key sequence assigned not only to its counter clockwise 
and clockwise directions, but also to it’s center detent. The example below implements 
JKL shuttling which is used by several nonlinear video editors. In other words, the 
shuttle will send a “j” when being turned counter clockwise, an “l” when being turned 
clockwise and a “k” when it is returned to the center position.
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Mouse Tab

The controls on the MCS2 can be made to emulate the Macintosh mouse. Buttons can 
perform clicks and the Jog Wheel and Shuttle Control can perform horizontal and 
vertical moves and drags.
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The Mouse Action popup lists the actions available for the selected control. For 
example, if the Jog Wheel is selected the popup would look like this:

The Starting Location popup lets you choose where the click, move or drag will 
originate.

If you choose Don’t Capture, the mouse action will always begin at the current location 
of the Mouse pointer. If you choose any other option, you will be prompted to pick a 
point in one of the target application’s windows. The options in this menu determine how 
the MCS2 will find that point in the event that the destination window has been resized 
or moved.

Option When Destination Window is 
Resized or Moved

Relative to Window Top Left The start point will stay the same 
distance from the top left corner of 
the window.

Relative to Window Top Right The start point will stay the same 
distance from the top right corner of 
the window.

Relative to Window Top Percentage of Width The start point will stay the same 
distance from the top of the window, 
but it’s horizontal position will be a 
percentage of the window’s width..
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Option When Destination Window is 
Resized or Moved

Relative to Window Bottom Left The start point will stay the same 
distance from the bottom left corner 
of the window.

Relative to Window Bottom Right The start point will stay the same 
distance from the bottom right 
corner of the window.

Relative to Window Bottom Percentage of Width The start point will stay the same 
distance from the bottom of the 
window, but it’s horizontal position 
will be a percentage of the 
window’s width..

Relative to Screen Top Left The start point will stay the same 
distance from the top left corner of 
the screen, no matter what the size 
or position of the window.

For example, let’s say that a particular application has an onscreen shuttle slider in the 
lower right hand corner of it’s Timeline window, and the center of that slider is 100 pixels 
from the right of the window and 20 pixels from the bottom of the window. When the 
window is resized, the slider stays at 100 pixels from the right and 20 pixels from the 
bottom of the window.

Suppose the only way to access this program’s shuttle function is by dragging this slider 
left or right. You could program the MCS2 Shuttle Control to do a horizontal drag 
starting at 100, 20 Relative to Window Bottom Right.
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Once you have chosen from the Starting Location popup, you will be prompted to 
actually pick the starting point.

Make Sure the target application is open in the background, and that the destination 
window is visible. Hit the Capture button then position the mouse pointer over the 
desired starting point and type <COMMAND K>.
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The Inspector window will be updated to show the window name and coordinates 
where the click, drag or move should take place.

From now on, whenever you are in the target application and use the assigned control, 
it will move the destination window to the front, then click, move or drag at the selected 
location.

Once a window name and mouse location has been captured, you have the option of 
using a partial window name. This is useful in applications like Final Cut Pro, where the 
Canvas Window’s title always starts with the word "Canvas" but the rest of the window 
title changes depending on what you're editing. Normally, the MCS2 tries to find a 
window with the exact name as the window where the click was first captured, but if the 
window name has changed, it will fail. If you choose to have the MCS2 just look for the 
word Canvas in Final Cut Pro it will always find the Canvas Window, even if the exact 
name of the Canvas Window changed since the click was captured.

To use the partial name feature, click on the Partial Window Name checkbox. In the 
text box on the right, change the full window name to the partial name you want the 
MCS2 to use.
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MIDI Tab

An MCS2 can be made to appear as a MIDI device to MIDI applications. Any MCS2 
control can be programmed to send and respond to a MIDI message.

There are three radio buttons for choosing the type of MIDI message to assign.

None No MIDI message for the selected control. If some other type of 
action has already been assigned, the None button will be selected. 
Clicking on the None button will delete the currently assigned 
action.

Native MIDI Native MIDI actions send and respond to the MCS2 hardware’s 
built-in MIDI protocol. You would typically use this setting with an 
application which directly supports the MCS2 protocol. It could also 
be used with an application that has a MIDI “Learn” feature.

For convenience, choosing Set all Controls to Native MIDI in the 
Actions menu will assign Native MIDI actions to all of the MCS2 
controls on all layers in the current keyset.

Custom MIDI Custom MIDI actions send and respond to user defined MIDI 
messages. 
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When Custom MIDI is chosen, more controls will become visible for editing the custom 
messages.

The MIDI Message Type popup lets you choose any of the basic MIDI messages 
except for system exclusive and MIDI Time Code.

The first group of messages in the popup include a MIDI channel. If you choose one of 
these message types, a channel editor appears. You can either type or use the up and 
down arrows to set the channel. This editor accepts values from 1 through 16.
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All MIDI messages except for system exclusive are either one, two or three bytes long. 
The first byte always is the message type, called the status byte. If there is a MIDI 
channel, it is embedded in the status byte. The bytes following the status byte, if any, 
are referred to as data bytes and contain additional information such as note numbers, 
velocities, control values, etc...

If you choose a message type that is more than one byte long the 1st Data Byte ( and 
possibly the 2nd Data Byte) editor appears. You can set the data byte’s value by typing 
or using the up/down arrows. The editor accepts values from 0 through 127.

Instead of setting an absolute value for a data byte, you can check the Follows 
Control’s Value box. In this case, the value of that data byte is determined by the state 
of the MCS2 hardware control this message is assigned to. In other words, if you 
assigned a Custom MIDI Message to the Jog Wheel and the 2nd data byte was set to 
Follows Control’s Value, a number representing the movement of the Jog Wheel 
would be inserted as the 2nd data byte of the custom message. For MCS2 buttons, a 
value of 127 will be inserted for button presses, and 0 for button releases.

Following are some samples of the MIDI Tab’s appearance for various message types.
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To access the MCS2’s MIDI messages in your MIDI application, connect your 
application’s MIDI input and output ports to the ports labeled “MCS2”. Depending on the 
application, the ports may be labeled “MCS2 USB”. The exact method for connecting to 
MIDI ports varies from application to application. Consult the manuals of the MIDI 
applications you are using to learn how to do this.
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Emulation Tab

The MCS2 software has the ability to emulate other MIDI based control surfaces. This 
feature is useful if you are using the MCS2 with an application which doesn’t directly 
support the MCS2, but which supports one of these other control surfaces.

You can set any control on the MCS2 to emulate a control on one of these control 
surfaces using the Emulation Tab. The Emulation Tab is not available until you turn on 
Emulation in the Emulation Menu. Here you can choose None, Mode A, or Mode B. 
Mode A and B represent two different control surfaces. Which one you choose depends 
on the application you are using with the MCS2. More on this later.

The contents of the Emulation Tab varies depending on the type of MCS2 control that is 
selected. This is what you will see at first if you select a button.
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The Control Group popup lists the basic categories of controls that can be emulated by 
the selected MCS2 control. Checking Emulate this control: or choosing from the 
Control Group popup will assign an Emulation action to the selected control. It will also 
display either a second popup or a numerical editor for choosing which control in the 
group to emulate.

For some control categories, such as Transport, the individual controls in that category 
have names, such as Rewind, Fast Forward, Stop, Play and Record. For these 
categories a second popup will list the control names.

For other categories, such as F-Keys, the controls are just numbered. For these 
categories a numerical editor will appear. This allows you to either type or use up/down 
arrows to set the control number.

The Jog Wheel only has one choice, Emulate Jog Wheel.

You cannot assign Emulation actions to the Shuttle Control because none of the 
emulated control surfaces have this function.
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For convenience, choosing Set all Controls to Emulation in the Actions menu will 
assign Emulation Actions to many of the MCS2 controls on all banks in the current 
keyset. Some MCS2 controls do not correspond to any controls on the emulated control 
surfaces, so those controls are left unassigned.

The following assignments are made when Set all Controls to Emulation is chosen. 
The assignments are also applied to the Option, Shift and Option Shift banks. If Option 
and Shift Keys are Programmable is checked in the Preferences dialog then there is 
only one bank and the modifier keys are also assigned.

MCS2 Control Assignment

Jog Wheel Jog

Rewind Rewind

Fast Forward Fast Forward

Stop Stop

Play Play

Record Record

Option modifiers: option

Shift modifiers: shift
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Special Tab

The Special Tab is a collection of actions that don’t easily fit into other categories.

Currently, the choices are:

None No Special Action for the selected control. If some other type of 
action has already been assigned, the None button will be selected. 
Clicking on the None button will delete the currently assigned action.

Developer Mode This is intended for use with applications which directly support the 
MCS2. This action uses messaging protocols built into Mac OS X to 
communicate with these applications.

You normally wouldn’t use this mode unless you knew that an 
application you were using supported it. 3rd party developers who 
support this mode would typically ship MCS2 keysets along with their 
applications.

For convenience, choosing Set all Controls to Developer Mode in 
the Actions menu will assign Developer Mode Special Actions to 
all of the MCS2 controls on all layers in  the current keyset.
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Built In Actions Tab

The built in actions are actions that are predefined for specific applications. When you 
choose a keyset, the built in actions appropriate to that keyset’s application are 
displayed. If no built in actions have been defined for the current application, the display 
will be blank.

The built in actions are presented in two columns. The left hand column lists basic 
categories and the right hand column lists the actual actions. Clicking on a category in 
the left hand column will change the list of actions displayed on the right. Double-click 
an action name to assign it to the selected MCS2 control.

Most of the categories and actions correspond to the keyboard shortcuts listed in the 
target application's manual. However, there are also actions defined by JLCooper that 
are not simple keyboard shortcuts. These actions will always appear at the beginning of 
the list, and there will be a separator line between them and other built in actions.
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Keyset Summary Window

The Keyset Summary Window displays information about several controls at once, 
making it easier to tell at a glance how a particular keyset is set up. You choose the 
Keyset Summary from the Windows menu.

The window has three columns. The first column lists the currently active keysets. 
These are the same keysets that appear in the Keysets Menu. Clicking on a keyset in 
this column will change the selected keyset, just as if you had chosen a keyset from  the 
Keysets Menu. Conversely, choosing a new keyset from the Keysets Menu will cause 
that keyset to be selected in the Keyset Summary Window.

The second column lists controls grouped by function and/or bank. Selecting one of 
these groups will cause the third column to display all of the controls in that group. Each 
control name is followed by its Name, if any, and a description of its assigned function. 
Clicking on a control in this column will cause that control to be selected in the main 
window and its information to be displayed in the Inspector Window for editing.
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Final Cut Pro™ Support
Final Cut Pro™ and Control Surfaces

With FCP version 5 some support for MIDI control surfaces was added. While only 
audio parameters and transport functions are controllable via MIDI, the MCS2 software 
not only emulates the supported control surfaces, it also can control many other 
parameters in FCP.

The MCS2 is not limited to just the functions included in Final Cut’s MIDI control surface 
support. With its built in functions and the ability to emulate the mouse and keyboard 
coupled with FCP’s control surface support, many functions in Final Cut Pro can be 
controlled with the MCS2.

Final Cut Pro™ Shuttle

The FCP Built In Shuttle command works equally well in the Timeline, Canvas, Viewer 
and Log and Capture windows.

Using the MCS2 with Final Cut Pro

To use the MCS2 with FCP, first run the MCS2 application and import the Final Cut 
keyset provided by JLCooper. Now run Final Cut and open the Control Surfaces dialog 
from the Tools menu. Click on the “+” button to add a control surface and choose 
Mackie Control. Then choose MCS2 USB - MCS2 for the input connection and output 
connections. Click OK to exit the dialog.

Final Cut requires the Audio Mixer (Tools Menu) to be open in order for control surface 
support to be active. You might want to save a window layout that has the Audio Mixer 
open.
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The MCS2 Final Cut Pro Keyset

The MCS2 Final Cut Pro keyset uses a combination of emulated controls, mouse 
emulation, keystrokes and built-in commands. It is fully customizable using the 
techniques presented in this manual, so you can easily adapt it to your working style.

Here are the control assignments in the FCP keyset. Note that if you have chosen 
Option and Shift keys are programmable in the MCS2 Preferences only the (no 
modifiers) bank will be active and the Option and Shift buttons will perform the actions 
shown below. Otherwise, all the banks will be available, and the Option and Shift 
buttons will act as bank selectors.

MCS2

(no modifiers)
FCP MCS2

(option button 
down)

FCP

Rewind Emulation- transport: 
rewind

Option Rewind Built In- Goto: Go to 
Previous Marker

Fast Forward Emulation- transport: 
fast forward

Option Fast Forward Built In- Goto: Go to 
Next Marker

Stop Emulation- transport: 
stop

Option Stop Built In- Mark: Add 
Marker

Play Emulation- transport: 
play

Option Play Emulation- transport: 
play

Record Built In- Render: 
Render All: Both

Option Record Built In- Mark: Delete 
Marker

Jog Emulation- jog Option Jog Emulation- jog

Shuttle Built In- Jog and 
Shuttle: Shuttle

Option Shuttle

Option Built In- Show Viewer

Shift Built In- Show 
Canvas
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MCS2

(shift button down)
FCP MCS2

(option -shift 
buttons down)

FCP

Shift Rewind Built In- Goto: Go to 
In Point

Option Shift Rewind Built In- View  Menu: 
Zoom Out

Shift Fast Forward Built In- Goto: Go to 
Out Point

Option Shift Fast 
Forward

Built In- View  Menu: 
Zoom In

Shift Stop Built In- Mark: Mark 
In

Option Shift Stop Emulation- transport: 
stop

Shift Play Built In- Mark: Mark 
Out

Option Shift Play Built In- Transport: 
Play Around Current 
Frame

Shift Record Built In- Mark: Clear 
In and Out

Option Shift Record

Shift Jog Emulation- jog Option Shift Jog Key Sequence:  
Counter Clockwise - -  
Clockwise - =

Shift Shuttle Option Shift Shuttle
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Final Cut Pro X™ Support 

Unlike Final Cut Pro 7, FCP X includes no built-in support for control surfaces. However, 
the MCS2 is still quite useful with FCP X because JLCooper has converted all of the 
FCP X keyboard shortcuts into MCS2 Built-In Commands.

JLCooper has included a Final Cut Pro X keyset which has assigned Built-In 
Commands to many of the MCS controls, but which still leaves room for customization.

Following is a list of the FCP X keyset assignments. Note that if you have chosen 
Option and Shift keys are programmable in the MCS2 Preferences only the (no 
modifiers) bank will be active and the Option and Shift buttons will perform the actions 
shown below. Otherwise, all the banks will be available, and the Option and Shift 
buttons will act as bank selectors.

MCS2

(no modifiers)
FCP X MCS2

(option button 
down)

FCP X

Rewind Play Reverse Option Rewind Go To Previous 
Marker

Fast Forward Play Forward Option Fast 
Forward

Go To Next Marker

Stop Stop Option Stop Add Marker

Play Play Option Play Delete Marker

Jog Jog Option Jog Zoom

Shuttle Shuttle

Option Color Board

Shift Audio Enhancements
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MCS2

(shift button down)
FCP X MCS2

(option -shift 
buttons down)

FCP X

Shift Rewind Go To Beginning Option Shift Rewind Event Browser

Shift Fast Forward Go To End Option Shift Fast 
Forward

Timeline

Shift Stop Set Selection Start Option Shift Stop Inspector

Shift Play Set Selection End Option Shift Play Event Library

Option Shift Record Project Library
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Soundtrack Pro™ Support
Setting up the MCS2 for use with Soundtrack Pro is almost identical to setting up for 
Final Cut Pro.

Open the MCS2 application and Import the Soundtrack Pro keyset or create a keyset of 
your own. If you create your own, start by setting the Emulation Mode to A then 
choosing Set All Controls to Emulation from the Actions menu. Later on you can 
customize this keyset with built-in commands, key sequences and mouse actions.

The next time you run Soundtrack Pro, open the Preferences dialog from the 
Soundtrack Pro menu then go to the Control Surfaces panel. Click on the “+” button 
to add a control surface and choose Mackie Control. Choose MCS2 USB - MCS2 for 
the input connection and output connections. Click OK to exit the dialog.

The Soundtrack Pro Keyset

The Soundtrack Pro keyset is a combination of emulated actions, keystrokes and built in 
commands.  Note that if you have chosen Option and Shift keys are programmable 
in the MCS2 Preferences only the (no modifiers) bank will be active and the Option 
and Shift buttons will perform the actions shown below. Otherwise, all the banks will be 
available, and the Option and Shift buttons will act as bank selectors.

MCS2

(no modifiers)
Soundtrack Pro MCS2

(option button 
down)

Soundtrack Pro

Rewind Emulation- transport: 
rewind

Option Rewind Built In- Add new 
track to Timeline

Fast Forward Emulation- transport: 
fast forward

Option Fast Forward Built In- Add new bus 
to Timeline

Stop Emulation- transport: 
stop

Option Stop Built In- Remove 
selected track, bus, 
or submix from 
Timeline

Play Emulation- transport: 
play

Option Play Built In- Select track 
above currently 
selected track

Record Emulation- transport: 
record

Option Record Built In- Select track 
below currently 
selected track
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MCS2

(no modifiers)
Soundtrack Pro MCS2

(option button 
down)

Soundtrack Pro

Jog Emulation- jog Option Jog Emulation- jog

Shuttle Option Shuttle

Option Built In- Viewing the 
Timeline: Zoom out 
horizontally

Shift Built In- Viewing the 
Timeline: Zoom in 
horizontally

MCS2

(shift button down)
Soundtrack Pro MCS2

(option -shift 
buttons down)

Soundtrack Pro

Shift Rewind Built In- Move 
playhead to 
preceding marker

Option Shift Rewind

Shift Fast Forward Built In- Move 
playhead to next 
marker

Option Shift Fast 
Forward

Shift Stop Built In- Insert time 
marker at playhead

Option Shift Stop Emulation- transport: 
stop

Shift Play Built In- Insert beat 
marker at playhead

Option Shift Play Built In- Start 
playback from 
beginning

Shift Record Option Shift Record

Shift Jog Emulation- jog Option Shift Jog Emulation- jog

Shift Shuttle Option Shift Shuttle
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Cubase™, Logic Pro™ and Nuendo™ Support

The keysets for all these programs were created using Set all Controls to Emulation 
Mode A. The assignments are listed here again for convenience.

MCS2 Control Assignment

Jog Wheel Jog

Rewind Rewind

Fast Forward Fast Forward

Stop Stop

Play Play

Record Record

Option modifiers: option

Shift modifiers: shift

To use the MCS2 with any of these applications, set the application up to use the 
Mackie Control connected to the MCS2 input and output ports. Refer to the manuals for 
these applications for details on setting up control surfaces.

Digital Performer™ Support

The Performer keyset uses a combination of Emulation Mode A actions and key 
sequences. If you have changed the keyboard shortcuts for Go To Next Measure, Go 
To Previous Measure or Click On/Off in Performer (Setup > Commands), then you 
will need to reprogram the keyset’s Shift Button and Jog Wheel to match the changes 
you made in Performer.
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The first step in using the MCS2 with Performer is to create an MCS2 Device in Audio/
MIDI Setup. Then connect the device to the MCS2 MIDI driver. Audio/MIDI Setup can 
be found in the /Applications/Utilities folder.

Next, open Performer and choose Control Surface Setup... under the Setup menu. 
Choose Mackie Control from both the Driver and Unit popups and MCS2-16 from the 
MIDI popup. Click OK.

Here are the assignments in the Performer keyset:

MCS2 Control Assignment

Jog Wheel Jog

Rewind Rewind

Fast Forward Fast Forward

Stop Stop

Play Play

Record Record

Option Toggle SMPTE/Beats Display

Shift Click On/Off
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Garage Band™ Support

The keyset for Garage Band uses key sequences to trigger transport functions. The 
Option and Shift buttons send Up and Down Arrows and can be used for selecting items 
in. For example, if track 2 is selected in the main window, pressing Option will select 
track 1, while hitting Shift will select track 3. This works in other lists such as the Loop 
Browser and Effect Browser.

Here are the assignments:

MCS2 Control Assignment

Jog Wheel Jog

Rewind Rewind

Fast Forward Fast Forward

Stop Stop

Play Play

Record Record

Option Select Next Higher

Shift Select Next Lower
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Pro Tools™ Support

The Pro Tools keyset uses a combination of Native and Custom MIDI actions.

The MCS2 Native MIDI protocol is similar to that of the JLCooper CS-10, which works 
with ProTools. You will need to have a CS-10 Profile which is compatible with your 
version of ProTools. The CS-10 profile for Pro Tools 8 can be found on Digidesign’s 
website at Legacy MIDI Controllers - Pro Tools 8 . For earlier versions of the CS-10 
profile, go to Digidesign and perform a search for “Legacy Controllers”.

Follow Digidesign’s instructions for installing the profile then launch ProTools. Choose 
Setup > Peripherals and click on the MIDI Controllers tab. Choose CS-10 from the 
Type popup and MCS2 from both the Receive From and Send To popups. Click on the 
OK button.

Here are the assignments for the Pro Tools keyset:

MCS2 Control Assignment

Jog Wheel Jog

Rewind Rewind

Fast Forward Fast Forward

Stop Stop

Play Play

Record Record

Option Jog Mode On

Shift Shuttle Mode On

Once you have entered Jog mode with the Option button or Shuttle mode with the 
Shift button you need to press the Stop button to return to normal transport mode.
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